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Mew, ., Ckrl+m
CIpEn. .. Chrl+C
Zhrl+-F

~ |\ |

Mew Project \Wizard. ..
IE}' Cpen Project. .. krl+1
Convert Max+PLUS 1T Project. ..
Save Projeck

Close Project

s _ o

New Project Wizard Diectory, Name,
Top-Level Entity

Mew Project Wizard: Directory, Mame, Top-Level Entity [page 1 of 5} il

What iz the warking directarny for this project?

IE:"naltEra"-.quartu342"-.m_l,lqEprniects"-.FF'G.-’-'-._Ied_test

Wrhat iz the name of thiz project?
|FPGA_led_test

What iz the name of the top-level design entity far thiz project? Thiz name iz caze sensitive
and muzt exactly match the entity name in the design file.

IFPGﬁJed}eﬂ

Uze Existing Project Settings .

¢ Back Mext > Finish | Ba |

Next

13
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Mew Project Wizard: Add Files [page 2 of 5] El
Select the design files you want to include in the project. Click &dd Al to add all desgign files
inn the project directom to the project. Mote: pou can alwavs add dezign files to the project
later.
File name: . | Add... |
File name | Type | Add Al |
Eemove |
Eropertiez |
Up | [
atr |
a
Specify the path names of any non-default ibranes. Uzer Librares. .. I
{Back [ Wext > | Finisn | il |
Next FPGA
Mew Project Wizard: Family & Device Settings [page 3 of 5] X|

Select the family and device you want to target for compilation.

E arnily:

Target device

" Auto device zelected by the Fitter from the 'Syvailable devices' list

f* Specific device selected in 'Available devices' list

Available devices:

EF1CaT 1000k - Filters
Package: Brm -

EP1C4F324C0 ,

EF1C4F400CE Fincount: | Any v

EP1CEF25600 S oond crade m

EP1CEQ24008 peed grade:

EP1CET144C8 .

EP1CT2F 25608 Core voltage: 13

EP1C12F324C8 [v Show Advanced Devices

EP1C1 2024008

EPIC20F32408

EP1C20F400C8

< Baclk I Hext > I Finizh I H 38 I

Family Cyclone FPGA ““Available
77 FPGA FPGA Filters

““Show Advanced Devices””

14
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Mew Project Wizard: EDA Tool Settings [page 4 of 5] x|

Specify the other EDA tools - in addition to the Quartuz || zoftware - uzed with the project.

[T EDA design entry / I j
isynthesistoal, . T
[T EDA simulation tool: I j
[T Mot available
[~ EDd timing analysis toal: I j |
[T Mot available

< Back I Hext > I Finish | HI B |

EDA Q2
Next

Mew Project Wizard: Summary [page 5 of 5] El

YWhen pou click Finizh, the project will be created with the following settings:

Froject directony:
C:/alteradguartuzd 2/ myg2projects/FFGA_led_test!

Project name: FPG4_led test
Top-level dezign entity: FPGA_led_test
Mumber of files added: ]

Mumber af uzer libraries added: 0
Device aszignments:

Family name: Cyclone |
Device: EP1C3T144C8
ED tools:
Dresign entiysynthesiz: <M ones
Sirnulatior: <Moner %
Timing analyziz: <Monesr
< Back Hext HoiE
Finish
File->New

15
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Device Design Files | Software Files I Dther Filez

AHDL File
:Block DiagramsS chematic File
EDIF File
Werilog HOL File
WHOL File
4 uuartus II - C:/altera/quartus42
F|Ie Edit Miew Project  Assignments
| ! Chrl+0
_Il:use ZhrH-F4
@ Mew Project Wizard. ..
ak. I C I
E}' Cpen Praoject. .. Ckrl+] anee
““Block Diagram Schematic File””> OK
““Blockl.bdf>~ File->Save as

““Add file to current project™”

fRAFE (L): | FPGA_led_test | - £k ER-
_ldb 5
o = R FFG 1 =d_test (B @)
{ATF2E (1) |Block Diagran/Schematic File (k. bdf) v | By
[, Add file to curent project

[ A

16
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Libraries:

i nandz N
g nand3

i nandd

B nandf

g nandd

-EF hor2

B o2

B nor3

i nord

B niorg —
Bt nor8

R ] lg hd
| »

Marne:
M J oL

=

™ Bepeatinsert mode LTIl
[T Insert symbol as block Ll
[T Launch Megaiwizard Plug:n Ll
MegaWieard Plugin Manager.. | |0 oot
OK Gancel | |2 ic o in i

Libraries
Name OK

not input output symbol

i pin_name

input  output symbol ““pin_name pin_namel”~
Keyl LEDL

QuartuslI ““Assignments—>Pins””
17
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tcl Tcl
tcl Quiartusll
name  Setup.tcl file File>New other files

Device Dezign Files I Software Files  Other Files |

AHDL Inchude File

Block Sembal File

Chain Dezcription File
Hexadecimal [[ntelFormat] File
Memary Initialization File
SignalT ap | File
Tl Scrpt File
Text File
Yector Wwaveform File

Ok, Caricel

tcl Quartusl|
FPGA
tcl
““CT-SOPCx 7

1 EP1C3
#Setup.tcl
# Setup pin setting
set_global_assignment -name RESERVE_ALL_UNUSED PINS "AS INPUT
TRI-STATED"
set_global_assignment -name ENABLE_INIT_DONE_OUTPUT OFF
set_location_assignment PIN_6 -to LED1
set_location_assignment PIN_52 -to keyl
2 EP1C6
#Setup.tcl
# Setup pin setting
set_global_assignment -name RESERVE_ALL_UNUSED PINS "AS INPUT
TRI-STATED"
set_global_assignment -name ENABLE_INIT_DONE_OUTPUT OFF
set_location_assignment PIN_1 -to ledl
set_location_assignment PIN_156 -to keyl

18
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““Add file to current

project”” Tools -> Tcl Scripts, Script
Setup, Run
Tcl Scripts x|
Libraries: Bun

= = Project
T —

&dd to Tel Toolbar

Cancel

Frewview:

#3etup.tcl =]
# Setup pin setting for EP1C3

set_global assignment -nsame REIERVE ALL UNUSED PINI ™i
set global azsignment -nsme ENABELE INIT DONE OQUTPUT O
set location assignwent PIN 6 -to LED1

set location assignment PIN 52 -to kKeyl

-,
4| | b

&

tcl Script ““FPGA_led test””
- C:\altera\quartus42\myg2projects\FPGA led test

C:\altera\quartus42\my g2projects\FPGA led test\

setup.tcl
5

Assignments%Device

File Edit View Project .ﬁ.55|gnmen|:5 Processing  Tools  Window  Help

s n@maﬁml:
=] 2] & Pins

'3'-51’ Tirning Settings. . L
En‘l‘_lt}r r g g .....

L IR
Cyelone: EPIC3| | A =2 " EDA Tool Settings.. . RS
L FEGA led t| | 3

& Settings. .. Crrl+Shift+E |- - - - -

19
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settings - FPGA_led_test x|
Categony: .
- Filex
- Usger Libraries Select the family and device pou want ta target for compilation.

- Timing Requirements & Options Farmily: IEZ_I,Iclone j Device & Pin Options. . I Bouting Dptions.. I
[+ ED& Tool Settings
[#- Compilation Process Settings Target device
[ Analysis & Synthesis Settings ™ Auto device selected by the Fitter friom the 'Available devices! list
[+ Fitter Settings (¥ Specilic device selected in 'Available devices' list
- Tirnitg Ahalyzer e o
- Design Azsiztant -

- SignalT ap Il Logic Analyzer : :
. . Available d 3
- SignalProbe Settings yaran e Jevices

o EF1C3T100CE Show in ‘Bvalable devices' list
- Simulator
[~ PowerPlay Power Analyzer Settings EP1CAF324C8 Package: Arp -

H
[+ Sofbware Build Settings EF1CAF400CE Fin count: Ay -
- HardCopy Settings EP1CEF25ECE =
EP1CER24008 Speed grade: [5 <]
EF1CET144C3
EP1C12F25ECE Care voltage: 1.5
EP1CTZF32408 V¥ Show Advanced Devices
EF1C120240C8
EF1C20F324CH
EF1C20F400CE
Migration compatibility; O migration devices selected Migration Devices...

Ok I Cancel |

£

FPGA EP1C3T144C8
““Device & Pin Options”~ Device & Pin Options
Configuration

Device & Pin Options x|

Tual-Purpose Fins I Yoltage I Pin Flacement I Error Detection CEC I
General Configuration | Frogramming Files I Unused Fins

Specify the device configuration zcheme and the configuration device.

Configuration goheme: I.fl‘-.ctive Serial [can use Configuration Device] ;I
[~

Configuration mode: IStandard

Configuration device
v Usze configuration desice:

LEaonfiguration D evice Dptions .

v Generate compressed bitstreams

Dezcription:

Specifies the configuration device that you want to usze az the means of configuring ;I
the target Cyclone device.

Beset |

T Bl |

Configuration

20
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OK

Window Help

d_test Jllzx#@%wuﬂﬂw@@

Quartusl| Message
Hawlis1on Hame Prisp led_ test
Top—lewel Entity Hame FPGA led test
Family Cyelone
% Device EF1C3T144C8
X
10 (0 %)
(1%
804 (0 %)
0%
7
1 FPGA
Q2 ByteBlasterl| PC
Tools—>Programmer
ml JignalTap II Logic Analyzer
=== In -Swstern Memory Content Editor
"\ Megawizard Plug-In Manager
H SOPC Builder. ..
Tol Scripts. ..
No Hardware
; Hardware Setup...| |N'1I Hardware Kade: IJMG j Progress:
I,
Wb 5t File L\i Device Checksum [ zercade ELDngﬁ[gaﬂ:g Weify Elf?gcl:{k
gl Stop FPGA_led_test sof EF1C3T144 (0046FES FFFFFFFF H N N
ﬁﬂ Luta Detect
Hardware Setup ““Hardware Setup”~

21
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Hardware Setup _ x|

Hardware Setting= | JTAG Settingzl

Select a programming hardware setup to use when programming devices. Thiz programming
hardware zetup appliez only bo the curent programmer windoss.

Currently selected hardware: Mo Hardware

— Availlable hardware items:

Hardware | Server | Part | A,dd Hardware{g

Hemave Hardwar

““Add Hardware”” ““Add Hardware~””
X

Hardware tppe: ButeBlastert or ButeBlaster | j
Part :ButeBlasterty or ButeBlazter ||

o i asterBlaster h

: EthernetBlazt

B aud rate: ernetbiazter —
SEerver narme: j
Server port:
Server pazsword:

Auta Detect Ok Cancel
Hardware type ““ByteBlasterMV or ByteBlasterl1”> OK
““Hardware Setup”” ““Currently selected hardware *~
ByteBlasterlI[LPT1] ““Close””

&, Hardware Setup...| |B.'-JtEE|~33lEf” [LPT1] bode: IJT.-'-‘-.G ﬂ Frogres
pi St File bﬁ)evice Checksum Usercode Er;ngflirgaﬂ:; Yerify Ell'ua:gk
Bl Stop zeqfled test.sof EP1C3T144 O004B09E FFFFFFFF Ol O Il

2 ByteBlasterll PC JTAG EPCS1

JTAG EPCS1 Pinl ByteBlasterll 10
Pinl
3 FPGA 5V
4 JTAG

22
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FPGA ““Mode >~
““JTAG~~ .sof
““Program/Configure”” ““/7 ““Verify””““Blank Check””
5 Flash
ByteBlasterl| EPCS1 ““Mode *~
““Active Serial Programming~~ .pof
LED D1
Setup.tcl & set_global_assignment -name
RESERVE_ALL_UNUSED_PINS "AS INPUT TRI-STATED"
EP1C6 V2.0 ““As inputs, tri-stated”
Flash FPGA
LED D2
FPGA & D1
1 KEVY1

““Assignments->Settings””
=@Eile Edit  Wjew ErDjEEtlEssignments Processing Tools  Window  Help

e .
D@ |8 4 B Dovie. =
: : — ®frs
Al =&
. | s < Timing Settings... ..o,
Entity 55’ e
Cyclone: EPIC D " EDWd Tool Settings. ..
_é’| Setkings. .. Ckrl+5Shift+E
-------- E?; FPGA_led | [1 = | = )
““Setting””
Settings - FPGA_led_test
Categony:
----- General
i Files
IJzer Libraries Select the family and device vou want to target for compilation.
- Device
Timing Requirements & Options Farrily: IE_I,I::IDne e
- EDA& Tool Settings B e

<<Device & Pin Options"" ““Device & Pin Options™~

23
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Device & Fin Options

Dual-Furpose Pins ] Voltage ] Pin Placement ] Error Detection CRC ]
Feneral ] Configuration ] Programming Files Unuzed Fins

Specify device-wide options for rezerving all unuzed ping on the device. To reserve
individual dual-ourooze configuration ping. oo to the Dual-Puroose Pins tab. To
rezerve ather ping individually, uze the Azsignment Editor.

Rezerve all unuzed ping

(" Az outputs, driving grotind
(™ Az outputz, driving an unspecified ignal

D ezcription:

Resemves all unused ping an the target device in one of three states: as inpuks that

are tri-ztated, az outputs that drive ground, or as outputs that drive an unzpecified

zighal.

Bezet
Wi il |
““Unused Pins”~ ““Reserve all unsued
pins”~ ““Device & Pin Options”~
Quartusll

8 KEY1
LED KEY1 LED
FPGA

Quartusll

FPGA LED

Quartusl FPGA

RS

24
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8 ® &

7res vroes 77 8

VHDL
““seg7led test””

Altera LPM

LPM symbol Libraries
Ipm_counter

X

Libraries: SRS
H & c/alera/quatusdlibraries/ a | | 1
B megafunctions SRS
EE arithmetic L
g ahaccumulate N N I A I
-~ altfp_mult LTI P CEUNTER
% altmemnmul Sl
g akmul_accum | | —{ szt
3 altmu_add AN I N P
4y divide Doririini T i down
Npnds s e
3 lpm_compare SO S all =
SRS zell =
'« Ipm_divide _Iﬂ CLliiiiiiii|eken cout [ —
‘I '. .................
Marne:

|Ipm_cc-untel J

[~ Bepeat-insert mode
[~ Insert symbol as block
[¥ Launch Megatizard Plug-n

Megawizard Plug-ln Manager... |

ok Cancel |

MegaWizard Plug-In Manager[page 2c] ﬂ .

Selected Megafunctions:  “which type of output file do you want to create?

[CFH_COUNTER v i

 WHDL

" Werlog HDL

What name dao you want for the autput file? Browsze. .. |

|C:\altera‘\quartus42\myq2proiects\EF"I C3 Exampleshzeg?le

Mote: To compile a project successfully in the Quartus ||
software, pour design files must be in the project directong or
a user library that you specify in the User Libraries tab of
General Settingz command (Praiect menul.

Your current user library directories are:

1 Lont azk me ror an output file name or the output file format again,
In future, name output files automatically and use the curent output file format.

[Mate: Y'ou can turn the Block Editor's auto naming and auto format selection
on and off with the Optionz command in the Tools mend. ]

Cancel | < Back | ﬂe:-:t[;: I Eirish |

25
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Megatizard Plug-In Mana

Iprn countedd
upsdown
— Lo
— > clock g[7..0]

Fezource Uzage
g Iut

Next

MegaWizard Plug-In Mana

Next

ger - LPM_COUNTER [page 3 of 6]

How wide should the ‘g’ output bus be? |8

Wihat should the counter direction be?

= Up anly
£ Dowven orly

8

| bitz

% Create an 'updown’ input /s ta allow me ko do batké

[1 zounts up; O counts dow]

Iprn countedd

upsdawn
=— Lpdown

clock o[7..0]

Rezaurce Uzage
g It

Documentation... |

ger - LPM_COUNTER [page 4 of 6]

v it

—"Which tvpe of counter do you want?

. Mu:udulus,“n;\;ith a count modulus of I

Cancel | <Eack| Mewt > | Finizh |

— Do you want any optional additional ports?
[~ Clock Enable
[~ Count Enablz

[~ Carmy-in
[~ Cary-out

Documentation... |

Cancel | <Eack| ﬂext%J Finigh |

Next

MegaWizard Plug-In Mana

lprm counterd
g upsdawn
= updoywvn
7.0
> clock al70ol

Rezaurce Uzage

ger - LPM_COUNTER [page 5 of 6]

— Do you want any optional inputs?

Synchronous inputs

[ Clear I lear
[ Load ™ Load
[~ Set [~ Set
% Settoall's % Sebtoalll's

{) Setln ID

Azpnchronous inputs

{" Setio IEI

Documentation... |

G lut

Next
Iprn countedl
....... H uplfdown
"""" —updoven
"""" 5 7.0
"""" o olock ol7..0l

Cancel | <Eack| Meut » | Finish |

Finish LPM_Counter
i yndown ceqe
SERREEE <<0>>
clock
aclr
q[7..0]
File=>New

26
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New x|

Device Design Files | S oftware Files I Other Files I

AHDL File
Block Diagram/Schematic File
EDIF File

‘-.feriln:ni HOL File

F. I Cancel |
OK VHDL bin27seg.vhd Quartusl|
entity VHDL

library IEEE;
use IEEE.std_logic_1164.all;
entity bin27seq is
port (
data_in : in std_logic_vector (3 downto 0);
data_out : out std_logic_vector (6 downto 0)
)i
end entity;
architecture bin27seg_arch of bin27seg is
begin
process(data_in)
begin
case data_inis
when "0000" => data_out <="0111111"; -- 0
when "0001" => data_out <= "0000110"; -- 1
when "0010" => data_out <= "1011011"; -- 2
when "0011" => data_out <= "1001111"; -- 3
when "0100" => data_out <= "1100110"; -- 4
when "0101" => data_out <="1101101"; -- 5
when "0110" => data_out <="1111100"; -- 6
when "0111" => data_out <="0000111"; -- 7
when "1000" => data_out <="1111111"; -- 8
when "1001" => data_out <= "1100111"; -- 9
when "1010" => data_out <= "1110111"; -- A
when "1011" => data_out <="1111100"; -- b
when "1100" => data_out <= "1011000"; -- c
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when "1101" => data_out <="1011110"; -- d
when "1110" => data_out <="1111001"; -- E
when "1111" => data_out <= "1110001"; -- F
when others => NULL;
end case;
end process;
end architecture;

Q2
Project->Set as top-level Entity

Locate L
% Set as Top-Lewvel Entity Ckr4-Shift+-3
Hierarhy &l '
vhd ““Start Analysis &Synthesis””
X 2@% T |» 5k b @0
|;tart Analysis & Synthesis |
Symbol
File—>Create/Update-> Create Symbol files for current file
4,
Project 2Set
as top-level Entity
symbol Libraries Project
x|

Lbraies: [ L

BB Project ||

LEF |pm_counter
B2 c/alteratquartusd2/libranies! i

O e ey [

| | I R PR

Marme:

e e EE T E R EE T P ET P EEEEEE

[~ Bepeatinzertmode |

[~ Inzert spmbol as block
I e |

Megatwizard Plug-in Manager... | i

Cancel |
OK
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lpm_counterd L
upfdawn|  E ... oL
G | R REL XY
I e g a0 (eI S
B
L hindzen R,
T« 1< 00 1) D e et s c
L —— data in3.0]  data_out. 0] s s Ll S B
SRR RS - SRR
protel
q[3..0] g3 90 4
q[7..4] inst6 data_in[3..0] inst
4 q[7..4] |
5. 6
tcl script tcl
d EP1C3 tcl
““CT-SOPCx 7z

#Setup.tcl

# Setup pin setting for EP1C3 main board

set_global _assignment -name RESERVE_ALL _UNUSED PINS "AS INPUT
TRI-STATED"

set_global_assignment -name ENABLE_INIT_DONE_OUTPUT OFF
set_location_assignment PIN_52 -to keyl

set_location_assignment PIN_53 -to key2

set_location_assignment PIN_54 -to reset

set_location_assignment PIN_68 -to seg7led1\[0\]
set_location_assignment PIN_61 -to seg7led1\[1\]
set_location_assignment PIN_56 -to seg7led1\[2\]
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set_location_assignment PIN_55 -to seg7led1\[3\]
set_location_assignment PIN_59 -to seg7led1\[4\]
set_location_assignment PIN_67 -to seg7led1\[5\]
set_location_assignment PIN_62 -to seg7led1\[6\]
set_location_assignment PIN_72 -to seg7led2\[0\]
set_location_assignment PIN_69 -to seg7led2\[1\]
set_location_assignment PIN_58 -to seg7led2\[2\]
set_location_assignment PIN_60 -to seg7led2\[3\]
set_location_assignment PIN_57 -to seg7led2\[4\]
set_location_assignment PIN_71 -to seg7led2\[5\]
set_location_assignment PIN_70 -to seg7led2\[6\]
> EP1C6 tcl

#Setup.tcl

# Setup pin setting for EP1C6 main board
set_global_assignment -name RESERVE_ALL _UNUSED PINS "AS INPUT
TRI-STATED"

set_global_assignment -name ENABLE_INIT_DONE_OUTPUT OFF
set_location_assignment PIN_156 -to keyl
set_location_assignment PIN_158 -to key2
set_location_assignment PIN_159 -to reset
set_location_assignment PIN_169 -to seg7led1\[0\]
set_location_assignment PIN_166 -to seg7led1\[1\]
set_location_assignment PIN_161 -to seg7led1\[2\]
set_location_assignment PIN_160 -to seg7led1\[3\]
set_location_assignment PIN_164 -to seg7led1\[4\]
set_location_assignment PIN_168 -to seg7led1\[5\]
set_location_assignment PIN_167 -to seg7led1\[6\]
set_location_assignment PIN_175 -to seg7led2\[0\]
set_location_assignment PIN_170 -to seg7led2\[1\]
set_location_assignment PIN_163 -to seg7led2\[2\]
set_location_assignment PIN_165 -to seg7led2\[3\]
set_location_assignment PIN_162 -to seg7led2\[4\]
set_location_assignment PIN_174 -to seg7led2\[5\]
set_location_assignment PIN_173 -to seg7led2\[6\]

6. Project 2Set
as top-level Entity

7. “€00*~
KEY1 KEY2 RESET
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SOPC

SOPC vs MCU DSP FPGA?

MCU DSP
FPGA
51 ARM
MCU
DSP FPGA
MCU DSP FPGA
SOPC MCU + DSP + FPGA SOPC MCU DSP FPGA
1 SOPC - MCU FPGA 16 32
MCU Altera FPGA CPU Nios
NioslI ARM
2 SOPC - DSP DSP
FPGA
DSP IP FFT
IIR FIR Codec FPGA MPEG4 /
DSP 10 DSP
Builder IP
3 SOPC - FPGA SOPC FPGA
FPGA MCU DSP
MCU+DSP+FPGA
ALTERA Cyclone Stratix Stratixl| FPGA
Altera FPGA SOPC

NioslI Altera SOPC Builder DSP DSP Builder
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DSP
SOPC
FIR FFT
Codec
Niosl|I
(MCU) | |
1 n
ARM SOPC
SOPC SOPC
Altera Nios I
Nios |l Altera FPGA Stratix||
Stratix Cyclone 200 DMIPS
60 IP Nios Il
Nios I
Nios 11
() 200 DMIPS
()
() FPGA Nios Il
()
() 1/0 FPGA
[ Niosll Cyclone FPGA 35
Niosll
10 20 FPGA Niosll
()

o Nios Il
32
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Nios Il IDE
Altera SOPC Builder Quartus Il
Quantusll  Niosll  SOPC
Quantusl | NioslI SOPC
SOPC FPGA
SOPC Buider
Niosll IDE
Quartusll  NIOS SOPC
SOPC Buider
ALTERA e
LPM Simbol
NIOS IDE

B
EGA

FPGA

«P°
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Quantusll  Niosll  SOPC

FPGA
Quartusll

Quartusll
FPGA

LED

NioslI
Niosll
Niosll IDE

g b~ W DNk

Cyclone PLL

LED
2
““sopc_led””

3

“sopc_led >~
QuartuslI

SOPC Builder NioslI

Niosll  SOPC

Tools=>SOPC Builder

x|

Syetem Mamme: Iniu:usii_u:|

3

@ Programmer HOL Language
Mega'u'u'lzard Flug-In Manager. ., ’7 f+ Werilog " WHDL
Tn:I Scripks... ! Cancel | 2k
niosii_c OK SOPC

1™ altera SOPC Builder - niosii_c

File Mocule System ‘iew Tools Help

8 [=[

System Conterts | Syster Generation

-

Eoard

Clock (MHz)

F5) Alters SOPC Builder
Create Mew Component.
—HAvalon Modules

IC =l Unspecified Board clk |s0.0

J]—_B. Mios | Processor - At
--Bridges

Target Device Family: ICyclone VI

@ Avalon To AHE E

@ Avalon Tri-State

Use Madule Matne Description Clock Baze I

Enicf

——Communication

Eo JTAG UART

@ SPI(3Wire Setia
i=play

@ UART (RS-232 @

L@ Character LCD 11
--EP1C20 Hios Developn
@ EPCS Serial Flast
@ Flash hMemory (C

B TS SOk T
<I I *
. All Available Components
o | ®| % O

| & Check |

Ak

& fowe g w ove Do

() Proklem checking for web-updates (Linable to download companent catalog; try aoain later )

Exit = Prey hlext = Generate
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Unspecified Board
Clock MHz 50.0
Target Device Family

Target

SOPC

CPU
Altera Niosll

1™ altera Nios II - cpu_0

Nios I Core | JTAG Debug Modulel Custam Instructiunsl

Select a Miog Il core:

Cyclone

CPU

Niosll Processor — Altera Corporation
Niosll/e

I@ Nios /e I O Nios Il/s |0Nios lIf |
- RISC RISC RISC
N 108 I I 32-bit 32-hit 32-hit

Selectar Guide Instruction Cache
Branch Prediction
Hardware M ultiply

Hardware Divide

Family: Cyclone

T yetem: 50 MHz

Performance at 50 MHz Upto ¥ DMIPS
G00-700 LEs
Twio Maks

Up to 20 DMIPS
1200-1400 LEs
Two h4ks + cache

Logic Lsage
Memaory Usage

Instruction Cache Size: |4 Khiytes vl Data Cache Size: |2 Khytes vI Hardirare hultifly: INone v[ [~ Hardware Divide

Instruction Cache
Eranch Prediction
Hardare Multiphy
Hardware Divide
Barrel Shifter
Data Cache

Dynamic Branch Prediction

Upto 54 DMIPS
1400-1800 LEs
Three M4ks + cache

= Frey | Mext =

Cancel |

Finish |

JTAG Debug Module

M altera Mios IT - cpu_0

{ custom Instructions |

Select a debugging level:

|® Lever O Level 2
JTAG Target Connection JTAG Target Connection
Download Software Download Software
Software Breakpoints Sofhware Breakpoints
2 Hardware Breakpoints
2 Data Triggers

O No Debugger

300-400 LEs
T f4Ks

800-500 LEs
Twwd fd ks

Mo LEs
Mo MdkKs

Aovanced debug licenses can be purchased from FS2. bittpa: e 52 comnf

Levell
.
O Level 3 CLevel 4
JTAG Target Connection  |[JTAG Target Connection

Dawnload Software
Software Breakpaints

2 Hardware Breakpoints
2 Data Triggers
Instruction Trace

On-Chip Trace

2400-2700 LEs
Four 4Ks

On-Chip Trace Buffer: |1 28 Frames vl

Download Software
Sofhware Breakpoints

4 Hardware Breakpoints
4 Data Triggers
Ingtruction Trace

Data Trace

On-Chip Trace

Off-Chip Trace
3100-3700 LEs

Four Mdls

Cancel | = Pray Mext =

Finigh

Finish Niosll CPU

cpu_0,
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=1L x|
File Module System  “iew  Toolz  Help
Syztem Contents I Mios IT Mare "opu_0" Seﬂingsl Systern Generation
¥ Ar-tera SOPC Builder - Board Clock (MHz)
Creste MNewy Component,
—HAvalon Modules Target: IUnspecified Board j clk ISD-D I
- Target Device Fatnily: ICycIone vI
@ fvalon To AHE E
@ Avalon Tri-State Uze Module Mame Description Clock Baze End IRQI
E-Communication = l; cpu_0 io= Il Processor - Altera .. |clk
@ JTAG UART instruction_master Master port
@ SPI(3 Wire Seria [E data_master taster port R@ 0 IRG 31|
@ UART (RS-232 3 fao_debug_tiodule  (Slave port 000000000  C:000007FF
—HDisplay
L@ cCharacter LCD 11 Q
—--EP1C20 Hios Developn
& EPCE Serial Flast
@ Flash Memory (C
B TTAN A S SO T
A I I »
Al Avyailable Components
LIRS
Add... | i@ check | A hove Up w hove Down
@ cpu_I0: Exception Address must be st least 0x20 bytes higher than the Reset Address. =
(i) cpu_D0: Unzpecified Reset Address | Exception Address
Cocpu_D: The reset address points to volstile memory. Execution of undefined code may ocour upon reset.

_I o - Chanaine the datanl reset acdd v eveartinn acdd rraates reninns af ninneahle mermnee Do nct channe the deafanlt addresses nnless won are i
1 i »

Exit | = Brew | hlext = | Genetate |

On-Chip Memory(RAM or ROM),( Avalon Modules -> Memory ->

) RAM. Memory Type RAM Data Width 32bits, Total
Memory Size 4K bytes

1™ On-chip Memory - onchip_memory_0 ||
— Memory Type
v RAM dwriteable)  ROM (read-onky)

[T Cual-Port Access

Elock Type: |ﬂutnmatic "’I

— Size

fermory Wickh: |32 'I hits
Total Memory Size: I 4| [\} II{h'g.-'tES "I
i

[i] Mermarny will be initialized from onchip_menmory_0.hex
i) Automatically choosing M4k blocks the only svailable block type)

Cancel = Prey et = Finish

Finish SOPC Builder
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1M sltera SOPC Builder - niosii_c

File Module System  Wiew Toolz Help

=10l x|

Systemn Conterts | Nios IT More "cpu_0" Settings I System Generation I

—@ AND 2901 28M ﬂ

Board
—@ Active Serial Mer

Clock {MHZ)

@ Irterface to User Target: IUnspecified Board

—& Legacy AMD 290
—@ Legacy IDTT1V4

Taret Device Farmily: ICycIone VI

|s0.0 |

LI clk
I

@ Legacy On-Chip

[F-Memory hodule Mame

Description

Clock Bese End | R

@ Dha, [
—@ EPCS Serial Flast
—4 Flash Memory (C
—& IDT71%416 SRAK

Elcpu_
instruction_master
data_master
frag_debug_module

onchip_memory_0

s U

— @ SDRAM Controlle
[=-0ther
—@ Dha, %

—® Interval timer
PO -
K — _>|J
. Al Available Components
op | | W C

&3 Check |

A |

Moz | Processar - Altera . |clk
hlaster part
haster port
Slave part

On-Chip Metnory (RAM or...|clk

& hove Up

IRQ 31|«
0x000007FF,
000001 FFF,

IRz 0
000000000
000001000

w hove Down

(5] cpu_I0: defaulting Reset Address, Exception Address to onchip_memory_0

Exit | = Brey |

Mext = |

. cpu_0: The rezet address points to volatile memory . Execution of undefined code may occur upon reset.
(7] Problem checking for web-updates (Unabls to dovwnload component catalod; try again later.)

Generate |

PIO( Parallel 1/0)(

LED Width 2 bits,

Avalon PIO - pio_D

Basic Settings | [rpUtOptions | Simulation |

Avalon Modules -> Other )

~ Width

[2[ bits

PIC wyicth must be %Ween 1 and 32 hitz

~ Direction

= Input ports only

= Qutput ports anly

" Bidirectional itri-state) ports

i~ Both input and output ports

Cancel = Erew

ext =

Finish

Finish SOPC Builder
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1M pltera SOPC Builder - niosii_c o [

File Module  System  Mieww Toolz  Help

System Cortents | Nios I More "cpu_0" Seﬂingsl System Generation

) e
to Legacy IDT?1V4-;I Board Clock iMHz)
@ Legacy On-Chip
S-Memory Taroet: IUnspecified Board LI clk 50.0

— @ DA, Target Device Family; ICycIDne 'l

— @ EPCS Serial Flast
— @ Flash Memory (C

@ DTT1V416 SRAN Use Module Matme Description Clock Baze End IRQl
— @ On-Chip Memary 4 = epu_0 Mioz || Processor - Aftera .. |clk
L@ SORAM Cortrolle instruction_mmaster haster port
E-Other data_master master port RGO IR 31| ¢
| @ DM . ftag_debug_module Slave port 0x00000000( 0x000007FF
— @ Irterval timer I onchip_memory_0  |(On-Chip Memary (RARM ar... |clk 0x00001000]  0x00001FFF)
| @ hiutex = pio_0 PIC (Parallel 10 clk 0x00000800) 0x0000050F

PIC (Parallel 1100
L@ System ID Periph

[=-AHB Modules =
KT T— ;I_I &

., Al Available Componants
op || & o

Add... | @ Check | e Move Lp w Move Doven

[0 cpu_0: defaulting Reset Address, Exception Address to onchip_memory_0
- cpu_D: The reset address points to volatile memory . Execution of undefined code may occur upon reset.
(7] Problem checking for web-updates (Unable to dovwnload compornent catalog; try agein later )

Exit | =i Hrey. | Mext = | Generate |

System ->Auto-Assign Base Addresses,

I8 Altera SOPC Builder - niosII_e

File Madule |S§.fstem YWiew Tools Help
e ey Auto-Assign Base Addre

T rpes Auto-Assign IRQs |
Sysetm->Auto-Assign IRQs,

File  Module |S§.fstem View Tools Help
System Cortent  Auto-Assign Base Addresses

T o

Nios Il More “cpu 0" settings
Reset Address Exceptiong Address Break
Location :
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1™ Altera SOPC Builder - niosii_c

File Module System Wiew Toolz  Help

Syatem Contert= | Nios I More “cpu_0" Settings I System Generation

~ Processar Configuration [%

Hiog llie Core
JTAG Debug Module ¢S bre akpoints)

Processor Function I hemory Module Offset Address
Reset Address onichip_memory_0 00000000 |Ce00000000
Exception Address onichip_memory_0 00000020 |Qe00000020
Ereak Location chu_Ditag_debug_module Ox00000020  |De<00001020

You can change Hios Il software settings, such as data memary, host communication, and
debugging communication, in the System Library properties of the Nios || IDE.

[~ Legacy SDK support. Generate headers, libraries, and memory contents with Nios SOK interfaces.

System Generation
HDL.Generate system module logic in Verilog,
Simulation.Create ModelSim(tm) project files

Generate,

1M Altera SOPC Builder - niosii_c _ Ol x|

File Module System “iew Tools Help

Cptions

B Fur nios 11 1DE |

|¥ HOL. Generate system module logic in Yerilog.

¥ Simulation. Creats ModelSimitin) projsct files.

(5] cpu_D: defaulting Reset Address, Exception Address to onchip_memory_0
Cocpu_0: The reset address points to volatile metnory. Execution of undefined code may oCour Upon reset.
(7] Problem checking for web-updates (Unakle to download component catalog; try again later))

Exit = Prev [ext = | gjﬂerate |

SUCCESS: SYSTEM GENERATION COMPLETED.
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Altera SOPC Builder - ni

File Module System “iew Toolz Help

=101]

Syatem Corﬂerﬂsl Nios IT hore "cpu_0" Settings

Qptions

I Fur riio= 11 IDE |

| HOL. Generate system module logic in Yerilog.

¥ Sirulation. Creste ModelSimitm) project files.

oo faltera/ quartusd bin/ quartus_emd —f nio=11_c_setup_guarins_natiwe_synihesziz. tel

B 2005.05.29 16:36:46 (#) Completed generation for system! niosii_e.

B 2005, 05,29 16:36:46 () THE FOLLOWING SYSTEM ITEMS HAVE BEEW GEWERATED:

SOFC Builder database @ C:falteraquartus4Z/myqZprojects/EFIC3 _examples/sopc_led/niosii_ec. ptf
System HDL Model : C:@/falterafquartus42/myg2projects/EFIC3 _examples/sope_led/niosii_c. v

System Generation Script
ModelSim Simulation Directory | Cfaltera/quartus42/myq2projects/EF1CI_examples/sopc_led/niosii_c_sim
® 2005.05.29 16:36:46 () SUCCESS: SYSTEM GEWERATION COMPLETELD.

Fress "Exit’ to exit.

Kl |

Info: Processing of Quartus IT Version 4.2 Build 15T 12/07/2004 ST Full Version started at time 05,/29/2005 16:36:44

© Cifalterafquartus4Z/myqPfprojects/EFIC3_examples/zopc_ledfniosii_c_generation_seript

(9] cpu_D was generated with full capabilities and must be compiled in Quartus Il with the same license.
(9] cpu_D: defaulting Reset Address, Exception Address to onchip_memory_0

cpu_0: The reset address points to volatile memory. Execution of undefined code may occur upon reset.
(7] Problem checking for weh-updates (Unakle to download componert catalod; try agsin later )

Exit | = Prev | [HeExt = Re-Generate

Exit SOPC Builder
Quartusll

Quartusll

niosl|
Niosll
Symbol

niosii_c

CPU
Project

Libranes;
=l E Project

& &:.v'a|tetér’quartus42f’|iblaries."

clk
reset_n

out_port_fram_the _pio_0[1..0]

4 |

Name:

|niosii_c
[~ Bepeatinzert mode

[ Insert symbol a5 block
[~ Launch Meaawizand Plug-n

Meqawiizard Plug-ln Manager...

ok LCancel |

OK

nios

C
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FIIEISII -

e 1= |4

— reget_n .......

out_port_from_the_pio_0[1..0]

PLL QuatuslI PLL

CPU

Symbol

OK

Libraries:

E & Project “
WEF niosi_c —

B E c/ateratquartuzd 2 libranies?

S megafunctions

FHED arithmetic

HE embedded_logic

FHED gates

= [l

altedr_r
altcd_ts
altclkctil
altclklock:
altddio_bidir
altddia_in
altddio_out
altdg
altdgs
altgeb
altlvds_m
altlvds_tw

w altpll_reconfig -
altearmmtba i sba
k

i ois

oA da i Bp da dp dp is s

E A A A AT AT AT AT AT AP AT AT

[~ Bepeatinzert mode
[ Inzert symbol a5 block
v Launch Megatwizard Plug-n

tegawfizard Plug-ln Manager... |

altpll

sy imnzlbc [1..0] clk[5..0
— fhin extelk[..0]
— pllena clkbad[1..0]
— clhswitch activeclock
1 aneset clkloss

— pfdena lochked

s | b2nia [5..0] scandataout
s entclkienals. 0] scandone

— sanclk

— =canacin

— scandata

—{ seanread

——| scanunte

Ok LCancel |
altpll
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MegaWizard Plug-In Manager[page 2c] El

Selected Megafunctionz:  Which bype of output file do vow want to create’?
|ﬂLT FLL

" Yerlog HOL

YWhat name do you want For the output file? Browse... |

|I::'\altera"-.quartusdE'xmyqEprniects"sE F1C3_exampleszopc_|

Mate: To compile a project successfully in the Quartusz |1
zoftware, your design files muzt be in the project directory or
a uzer library that you specify in the zer Libraries tab of
General Settingz command (Proiect menul.

Y'our current wzer ibrany directones are;

| Lonnaszk me ror an output file name or the output file format again.
I fukure, name output filez automatically and uze the curent output file format.

[Mate: You can turk the Block Editor's auta naming and auta format selection
an and aff with the Options command in the Toaolz men.]

Cancel | < Back | Hest > l\l Eirizh |
i
Next

““Which Device family will you be using?”” Cyclone

““Which device speed grade will you be using”” any

““What is the frequency of the inclk0 input?”” 25.00MHz
16MHz

16MHz
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MegaWizard Plug-In Manager - ALTPLL [page 3 of &]

altplld
inclk0 cl
inclkD fraquency: 26000 hiHz
llena Operation hiede: Mormal locked
arezet

Coyclone

Next

MegaWizard Plug-In Manager - ALTPLL [page 4 of §]

altplid

inclk0

inclkd frequency: 25000 hiHz
Operation hiode: Homal

Next cO
““Use this clock””

Able ta irplement the requested PLL

b3

Jurnp to page for: IGeneraIx’Modes VI

— General
I Cyclone - l

Ay T

I25[DD IMHz 'l

Which device Family will you be using?
Which device speed grade will vou be using?

“What iz the frequency of the inclock input?

I~ Setup PLL it YD S mode [rata rate; ISUU, oo VI Hbp
—PLL type

Which PLL twpe will vou be using?

€7 Fast PLL

€ Erhanced FLL
i+ Select the PLL type automatically

— Operation mode
How will the: PLL outputs be generated?

¢ Use the feedback path inside the PLL
£ |n Nomal Mode
€ | Sowrce-Synchronous Compensation Mods
= In Zemo Delay Bufer Mode
£ With no compensation

| Create an 'fhin input for an external feedback [External Feedback kMaode]

‘whick output clock will be compensated for'? cl -

Documentation

Cancel I < Back | Mest » | Firizh |

Able ta implement the requested PLL

Jump to page for: I Sean/Lock A l

= Dymarnic configuration
I~ | Create optional inputs for dynanic reconfiguration

Some PLL: have fewer independent outputs and require ez data to
reconfiaure. These PLLs have a sharter seam chair.

Wihich sean chan type will you be using?
% Long chait: &I 6 core and 4 external clocks are available

7 Short chain: Limited to 6 core clocks, with optional extemal clock

— Optional inputs
[~ Create an ‘pllena’ input to selectively enable the PLL

[~ Create an ‘areset’ input bo asynchronously reset the PLL

[ Create an ‘pidena’ input to selectively enable the phasedfrequency detector

— Lack output

L3

Documentation |

Cancel I <ﬁack| Nest » | Finizh |

““Enter output clock parameters”?;

““Clock multiplication factor”~

CPU
25MHz

altpll

““Clock division®~
cO
50MHz

43
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Megavizard Plug-1n Manager - ALTPLL [page 5 of 1]

el irequery: 25000
Cpeermk iede : Hamral

(= 3
o

R

00

Pl didgil O (3
B0

sy

x|
il - Core Datput Cloch Juemp in pncye fior B Clack el -
Abds b riphement e requeibad PLL
' Live s cleck Pequerted sesings Actyal gettings
™ F i omitgud ko lnmpaney 10 MHz = SOOM000
% Endrd oaipik choch parametens:
— Dlock [iglecalion: faciin F| e | —_— 2
Chock givision lacsne 1 | 4 1
Cleck phasa shit = A
. T
Check duty cpchs (%) | i
Mewm Db
(o
ED
Docunentaton | Coreel | <Back | Hews | Eewh |

pll

cl

el

[ led[1.0]

Finish Quiartusll
altplio
niasii_c
------- i —clk
------- NCKD | o fraquency: 25.000 MHz £l o
....... Operation hade: Mormal resen
ol Clk |Ratio [Ph dgf D o) out_port_from_the_pio_01 0]
L o0 | @1 ) ooo | soo0 ]
....... in=t
DT inst Cyclone
clk  reset
altplio
elk O LT NEKD ) incikd frequency: 25,000 hHz c0
Operation hdode: Hormal
Clk |Ratio | Ph dgy| D )
c0 | 21 | oo | 5000
inst1 Cyelone
niosi
clk
reset_n
out_paort_from_the_pio_0[1..0] UIEUT
inst
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7 tcl
o EP1C3 tcl

““CT-SOPCx 7z
#Setup.tcl

# Setup pin setting for EP1C3 main board

set_global_assignment -name RESERVE_ALL_UNUSED PINS "AS INPUT
TRI-STATED"

set_global_assignment -name ENABLE_INIT_DONE_OUTPUT OFF
set_location_assignment PIN_16 -to clk

set_location_assignment PIN_54 -to reset

set_location_assignment PIN_6 -to led\[0\]

set_location_assignment PIN_7 -to led\[1\]

%) EP1C6 tcl

#Setup.tcl

# Setup pin setting for EP1C6 main board

set_global_assignment -name RESERVE_ALL_UNUSED PINS "AS INPUT
TRI-STATED"

set_global_assignment -name ENABLE_INIT_DONE_OUTPUT OFF
set_location_assignment PIN_28 -to clk

set_location_assignment PIN_159 -to reset

set_location_assignment PIN_1 -to led\[0\]

set_location_assignment PIN_2 -to led\[1\]

8 Flash EPCS1 EPCS1

FPGA

Nios IDE Nios Il IDE
File -> New -> Project New Project C/C++ Application
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JNew Project x|
Select o9
The Mios 1T IDE will create and manage the makefile to build this project,
The Mios 1T IDE will also create and manage an associated system library, ﬁ
&ltera Mios I ‘.
- Simple: f?.l” Systemn Library

ra‘} Advanced CJC++ Project
(@ Managed Library Project

< Back I [dext = I Eimishi | Cancel |
Next Hello LED

JNew Project il

C/C++ Application
SOPC Builder system file must be specified @

Marne: IhE||D_|eE|_D

[ Use Default Location
Location: Ic:'I,aII:era'I,kjI:s'l,nil:u52'I,bin'l,ecIipse'l,warkspace'l,hella_led_ﬂ Browse, |

—Select Target Hardware

SOPC Builder System: | | Browse... |
CPU: | =

—Select Praject Template

Count Binary ;I — Descripkion
Dhirystane Shifts LEDs back and Farth,

Hello Freestandin
M - Detalls
Hello Micro fio3-11
ello Microcf This is a simple freestanding application that will runon =

:2::2 xg::g Small any Mios II system with an LED PIO named ‘led_pio’
Memary Test such as the standard or full-Featured hardware
Simple Socket Server example designs. It does not use main) as it's entry
MicroC[O5-IT Message Box point, Instead, it uses alt_main), an alternative entry
MicrofO5-IT Tukorial point which bypasses all initialization, a technique that

can reduce overall code size, Be warned however, I j

Web Server I
Zip Filing Swstem -

< Back | [dext = | Eirish I Cancel

““SOPC Builder System®~ ““Browse””
““niosii_c.ptf~~ Niosll IDE
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New Project x|

C/C++ Application
Click. Finish to create this project with a default syskem library @

Marne: Ihellu::_leu:l_l]

¥ Use Defaulk Location

Locakion: IC:'l,altera'l,quartus42'l,m~;.-'q2pru:ujeu:ts'l,EF‘1C3_e:<amples'l,supc_led'l,snftware'l,hellu:u_ Browse, ., |

—Select Target Hardware

CPL: Iu:pu_III

—Select Project Template

Zounk Binary ﬂ —Descripkion
Dhirystone Shifts LEDs back and Forth,

Hella Freestandin
E]ﬂ_ ~Ditails

Hello MicroC)03-11

Hella \Warld

Hello World Small

Memory Test

Simple Socket Server
Micro f03-11 Message Box

This is a simple freestanding application thak will run on =
ary Mios II swskem with an LED PIC named 'led_pic’

such as the skandard or full-featured hardware

example designs. It does nok use maint) as it's entry
paoint, Instead, it uses alt_maind), an alkernative entry

Micro f05-11 Tukorial point which bypasses all initialization, a technique that

weh Server can reduce overall code size. Be warned however, If I
— -

Zip Filing Sy skem =

< Back | Fext = | Einish I Cancel

Finish Hello LED 0

JC/C++ Development - hello_led.c - Nios II IDE
File Edit Mavigate Search Run  Project Tools  Window Help

IF-HRAe | R||FSX||$-%-&-||flcc-2-|B ¥ 2
+ x || [€]helo_led.c XI
l% P s R |:‘:‘:=§= E“ Uze alt maln as entry point for this £

Elﬁ- hello_led_o wf

Jcdtbuild
.cdtproject int alt main (void)

project {

application, skf alt_ub led = OxzZ;
Rl led.c alt ud dir = 0;
readme. bxt % rolatile int i:

122 hello_led_0_syslib [niosii_c]
*

F Infinitly =shift a wariable with one bi
* it to the LED PIO. Software loop prowv
=/

while (1)

{

if (led & Ox81)
hello_led.c
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int alt_main (void)

{

alt u8 led = 0Ox2;
volatile Int 1;
while (1)

{

Tfor(1=0;1<300000;1++) ;
led = Ox1;
*(unsigned Int *)PI0_0O BASE
for(1=0;1<300000;1++) ;

led = 0x2;
*(unsigned Int *)PI0_0 BASE

}

return O;

¥
10

““Properties””

Settings””
size (-Os

““General””

led;

led;

hello led 0

[€] hello

[E' Debug
B [E hell_le
- applica
- readme
#-1a# hello_led_0_
F-1aF Mios II Devi

Properties for hello_led 0
“<*= ““Optimization Level”~

Mew

Go Inko
GoTo

Cpen in Mew Window

Run As

Debug As

Build Project
Rebuild Project

Refresh

Close Project
Renarne
Delete

Team
Compare With
Replace With

Restare from Local Histary, ..

48
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JProperties for hello_led_0 = ol
¢~ Infa C/C++ Build
i pssociated System Library
= CJC++ Build —fctive configuration

i External Tools Builders

_ Platfarrm: INios II Executable
- Project References

=
Configuration: IDebug j Manage. .. |

—Configuration settings

=T niosz-el-gee Compiler Flags I
: -HA General Optirnization Level | Optimize most (-03)
E Preproceslsor " | Hone (-00)

= T ninsZ-glf-gee, linker Debug Level Optirnize (-0
- General Qptimize more (-02

Le

rInclude Paths —

Qptimize size (-0s)

Edit. ..
Blemate
Mawe Ug

Move Do

L

¥ Enable all Warnings (-}

Restore Defaulks | Apply |

oK I Cancel |

OK hello led 0
hello_led 0 syslib[niosii_c]

hello_led 0 syslib[niosii_c] ““Properties””
© e[S reaome.rx H —m e - -
3RS F=3 el |=d 0 svyslib [riosi_c
H-Ta8  Mios 11 Device Drivers Mew r
o Inka
GaTo 4

Open in Mew Windaw

Build Project
Rebuild Project

Refresh

Close Project

Fename

Delete

Team 3
Compare With r
Feplace With ¥

Restore from Local History...

EECTNE———

Properties for hello_led 0 syslib
““Configuration Settings”~ ““General”” ““Optimization Level”~
““Optimize size -Os *~
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JProperties for hello_led_0_syslib

~Info

M+ Build

- External Tools Builders
- Project References
Syskem Library

C/C++ Build

=10l x|

—#ctive configuration

FlatFarm: INios 11 Library

Configuration; IDebug

[
j Manage. .. |

—Configuration settings

E-T niosz2-elf-gec

B General

¢ -FA Preprocessor
= T nios2-elf-ar.archiver

------ B General

Carmpiler Flags I

Optimization Lewvel

Optimize mask (-03)

Debug Lewvel

~Inchude Paths —

Mone (-00)
Ciptimize {-011)
Cipkirnize rnare (-0

Ciptimize size {-0s)

Edit..
Remoye

Mowve g

LELEL |

[oye Do

¥ Enable all Warnings {-walli

CJC++ Build
External Tools Builders
Project References

““System Library”~
““Max file descriptors:”~ 4
profiling library~~

.'Properties for hello_led_0_syslib

System Library

““Clean exit (flush buffers)>~
““Reduced device drivers””

Restare Defaults | Apply |
oK I Cancel |

System library

““Small C library~~
I [m] 4]

—Target Hardware

SOPC Builder Syskem: IC:'l.altera'l,quartus42'|,myq2pr0jects'l,EP1C3_e><amples'l,sopc_led'l,niosii_c.ptF

Etawse. .. |

CPL: Icpu_U

—System Library Contents

- [rone Ginge treaded) =]
RTOE Options ... |

skdout: lm

skderr: Ih

stdin: InuII 'I

|4—
[T Clean exit (Flush buffers) W Reduced device drivers

[V Small C library ™ Link with profiing library
™ Modelsim anky, no hardware suppart

System clock timer:
Timeskamp kimer:

Max file descriptors:

Software Components.. |

—Linker Script
€ Custom linker script

Inone

Seleck, ., |

Program memary {,texk Ionchip_memory_lj 'l
Read-only data memory {.rodata): Ionchip_memory_lj 'l
Read/write data memory {.rwdata): Ionchip_memory_ﬂ 'l

% Use auko-generated linker scripk

OK

11

Help I Restore Defaults | Apply I
oK I Cancel I

““hello_led 07~

50
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> x| [
Mew 3
Go Inko
GoTa 3

Open in Mew Window

Run &s 3
Debug As 3

Rebuild Project Eg l

Build completed.

760 Bytes
3336 Bytes niosii_c 4K
f C-Build [hella_led_0]
Compiling hello led.c...
Linking hello led O.elf...
Info: (hello led 0O.elf) 760 Bytes program sSize (code + initialized data) .
Info: 3336 Eytes free for =tack + heap.
Post-processing to create onchip memory O.dat
Post-processing to create onchip memory 0.hex
WARHING: Default charset GEK not suprorted, using IZ0-5359-1 instesad
Post-processing to create onchip memory 0.svm
Build completed I
Tasks lC—BuiId ]Pruperties
12 ByteBlasterll FPGA JTAG 5V
Run—->Debug As—>Niosll Hardware
File Edit Mavigate Search | Bun Project Tools ‘Window Help
JE} - M=, | Ean J.ﬁbﬂun Last Launched Chel+F11 [# |J g - - J B w P
E«" qﬁcrcw P %Q&hug Last Launched Fi1 I
iRy | b Fun History P |oation, it will try to set a
% Eﬁ hella led 0 Run As F lpplication does not contain.
. Ea _Bina_ries Run... 3o the debugger is sble to
he application retains alt m
= Debug Debug History b -

#-[€] hello_led.c
application

Debug As

-*g‘ 1 Mios IT Hardwar

readme. bt Debug.. & Mios 11 Instruction Set Simulator
F-1z% hello_led_0_sysl Extarnal Taols b
F-la$  Mios I Device D T E m — l .
Niosll IDE Debug Perspective
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File Edit WNavigate Search PRun Project Tools  ‘Window  Help
[ -HRE R -%-& [ 9]%e-o-

%5 Debug (0 m | 3@ @ | B OFF E x || @ variables
:ﬁ hellu:u _led_0 Mios IT Hw cnnflguraf‘ﬂﬂ [Mios II Hardware] e =10
E| (2 Mios I1 EIF Debugger (5/29005 8:16 PM)
= {‘*}JJ Thread [0] {Suspended)
b= 2 alk_main) at hella_led.ci122
LB 1 _start()
ﬁt <kerminated > Mios II Download output (5/29/05 8;16 PM)
----- & niosZ-gdb-server aukpuk (5129005 516 PM)

i

If#hﬁilﬂ

1 |
‘ariables | Breakpo

[E heflo_ed.c
alt_us led = OxZ;
volatile int i;
while (1)
1

3

led = 0Ox1;

*junsigned int *)PIC 0 BASE
for (i=0; i<300000;i++])

led = 0O=2;

*junsigned int *)PIC 0 BASE

led:;

led:;
H
return 0O;

Resume Lg
led 11 |

Ei {termlnated} NIDS II Du:uwnlu:uau:l outpuk (5129105 &:26 PM)
----- & nins2-gdb-server output {5f29/05 826 PM)

= & CIC++

File Edit Mavigate Search Bum Project Tools  Window Help

|5 - R[5 [[35 - % -S| 9] -

1= > 0 W EE
=3 hello_world_2 Mios IT HW configuration [Mios IT Hardware)

El I"-Ju:us II EIf Del:uugger (6/1)05 12:47 PM)

B 11 Du:uwnlu:uad autput (6105 12:47 PM)
‘ &: Mios IT Termlnal Window (6105 12:47 PM)
----- &: nios2-gdb-server oukput (6105 12:47 PM)

13 Quartusll
EPCS1
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Quartusll Processing -> Star Compilation,
14 EPCS1
2 [ = [N |[oones BEEEL I AL
Z. Hardware Setup... |BPtBB'aS‘B'” [LPT1] Mode: | Active Serial Programming ¥ | F'rngress:l
Wi Start File Device Checksum  |Usercade Efﬂ%{;ﬂ:é very | B |
w Ciop sopc_led pof EPCE1 OIBE4152 00000000 O O
ol Auto Detect |
15 LED
RESET
LED LCD
Quartusll  Niosll IDE
SOPC
CT-SOPCx
FPGA/SOPC
FPGA
LED
LCD LED
KEY1 1 KEY2
1 LCD PC
Niosll
EP1C6 EP1C3
““EP1C6_Examples®” <““EP1C3_Examples®” ““all test””
1. 32 NioslI ““CPUO~~ ““Niosll/e””
““Levell””
2. ““onchip_memory 07* 32 4Kbyte
3. ““uart 07~ 9600 8 1
4. LED I0““pio_led”” 2 ““Qutput ports only~~
5. ““Timer0~~
6. I0““pio_key”” 2bits ““Input ports only”~
7. LCD ““pio_led _data~ 8bits ““Bidirection tri-state  ports>~
8. LCD ““pio_led_ctl”” 3bits ““Output ports only”~
9. 7 I0““pio_seg7led”” 8bits ““Output ports only>~
LCD SOPC Builder Character LCD
16X2 Optrex 15207 LCD

1602A LCD 8
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10 LCD 3 10 LCD
Icd e, lcd_rs, led_rw
Altera Character LCD 16X2 Optrex 15207
1602A LCD
Nios
— Board Clock (MHzZ)
Target: |Llnspecified EBoard j clk S04
Target Device Family: ICyclu:une vI
o L=e I hodule Mame Dezcription Clack Bus Type EBaze End IHGI
¥ [Ecpun flios || Processar - Atera Cor.|clk
=t instruction_master  Master part avalan
=t data_master haster port avalon IRz 0 IRz 31
! =+ jtag_debug_module [Slave port avalon | 0x00001000) 000001 7FF
v onchip_memory_0 |(On-Chip Mematy (RAM ar RO clk avalan | 0x00000000) 0:00000FFF
| ™2 uart_0 UART (R=-232 =erial por) clk avalon | 0x000041800) 000001 31F|[ 0
I v pio_led P2 (Parallel 1500 clk avalon | 0x00001840| 000001 54F I
! ¥ |Etimer_o Interval timer clk avalon | 0x00001820 0x0000155F [ 1
! [+ pio_key P2 (Parallel 1500 clk avalon | 0x00001850) 0x0000155F|[ 2
iILI ™2 pio_lcd_data P2 (Parallel 1500 clk avalon | 0x00001860( 000001 56F
™ pio_lcd_ctl PIC (Parallel 1 clk avalon | 0x00004870| 000001 57F
_| v pio_segfled PIC (Parallel 1000 clk avalon | 0x00001880) 000001 35F
V1.0 EPCS1
COM 9600
8 %
V2.0 USB
V2.0 V1.0 USB UART
CP2102 E’PROM AT24C32 EP1C3
4 Pins 10 SPI 10
EP1C3
E°PROM
4 Pins 10 SPI 10
USB UART SOPC
Cyclone
RS232 RS485 USB RS232
USB
USB
V2.0 USB
V2.0 USB UART USB
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USB
-40 +85
IMbits/s USB1.1
USB2.0
““\EP1C6_Examples\all test USB~~
1. USB
CT-SOPCx FPGA/SOPC
2.
SOPC UART
““uart_usb”” UART 115200
8 1
=g Mocdule Marme Dezcription Clock Buz Type Base End IRQI
[+ [Eepu_d Mios | Processzar - Al |clk
=4 instruction_master haster port avalon
=L data_master haster port avalon [Fecz O IRG 31
=+ jtag_debug_module Zlave port avalon [ Dx00001000| 000001 7FF
[+ onchip_memorny_ 0 On-Chip Memory (RA.. |clk avalon [ Dx00000000| Cx00000FFF
I uart_0 JART (RES-232 =erial ... [clk avalon | 0R00D01E00) 0:0000181F) ) 0
I pio_led PIS (Parallel 1120 clk avalon [ 0x00001860) 000001 S6F |
I timer_0 Irteryal timer clk gvalon [ 0x00001820) 0:x0000153F| ) 1
I pio_key PIS (Parallel 1120 clk avalon [ Dx00001870) Ox0000157F(| 2
I pio_lcd_data PIC (Parallel 1120 clk avalon [ 0x00001880) 000001 55F
I pio_lcd_ctl PIS (Parallel 1120 clk avalon [ 0x00001890) 000001 59F
W pio_seqgfled PO (Parallel 1120 clk gvalon  (0x000018A0) 000001 34F
[ uart ush ART (F{Sﬁﬂ zerial .. |clk gvalon | Dx00001830 Ox00001585F|] 3
uart ush: S-bit UART with 115200 baud,
. Move Up | N =stop bitz and M parity
(avalan)
3.
EPCS1
Nios
Niosll IDE

““SSCOM32.EXE™”

““SSCOMBS32.EXE~*”

55
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|LSSCOM3.2 (fE3E=E-DE(T T ), EMhttp:/ /www.mcu51.co -0l x|

FPGABSOPC—www. 21 control. com——
FPGARSOFC—www. 21 control. com——
FPGARSOPC——www. 2l control. com——
FPGARSOFC——www. 21 control. com——
FPGARSOPC——www. 2l control. com——
FPGARSOFC——www. 21 control. com——
FPGARSOPC—www. 2l control. com——
FRGABSOFC——www. 21 control. com——
FPGARSOPC—www. 2l control. com——

I
FTH I |Ef*|=:5 g | BFEE0 | BRE0 (T EmES
=05 [com v @ XFEO0 | BB | WIWVW MCUSICOM TR |
Nz (115200 = || [ DTR [~ RTS Trin{EF b i T Bsscon

0 - iE
seilo -] s [0 mar LR EELD
=1 HAE |1 *| [ HEXEi% [ miEsnT http: fwww. menSl. comfdownload/sscom. rar

Hedafir [Mone  + || FIFEEHRASE ¢ AR AR L Y

FiEsl |Mone |a1:-cdefg

W MEUS 1 com |50 Ri279 COM4EATH 115200bps &1 (CTS=0DSR=0RLSD=0
CP2102 USB  UART
COM USB
COM
COM 115200
8 1
EP1C6 EP1C3

“EP1C6_Examples 7> ““EP1C3 _Examples *” “<all test USB ”~

4.
USB
——EP1C6 V2.0 Flash
EP1C6 V2.0 8Mbyte SDRAM  2Mbyte Flash
EPCS1
Flash EP1C6
RAM SDRAM Flash

Niosll IDE  ““Flash Programmer>~
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/altera/kits/nios2/documents ““ug_nios2_flash_programmer.pdf”~
Nios IDE  Flash
““\EP1C6_Examples\>~ ““burn_flash_eplc6”” ““ucosll_test””
SDRAM
uc/OS-11 Nios 11
uc/OS-I1
uc/OS-I11
FAA
3 uc/OS-11
NioslI
uc/OS-lI ““\EP1C6_Examples\ucosllI_test””
Taskl Task2 uc/OS-I1
NioslI NioslI uc/OS-I11
——Jean J. Labrosse ““MicroC/OS-11 The Real-Time Kernel”>(Second
Edition) uc/OS-II

8 uc/OS-11
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CT-SOPCx FPGA/SOPC
CT-SOPCx
CT-SOPCx Altera Cyclone FPGA
FPGA/SOPC

1 FPGA

2 NioslI FPGA 32
DSP
ALTERA NI0S IDE
3 FPGA
CT-SOPCx
EP1C6 V2.0 SOPC
SDRAM Flash
FPGA Nios
SDRAM  Flash FPGA 10
FPGA
FPGA ARM DSP
FPGA
FPGA  1/0 170
FPGA

FPGA FPGA FPGA

1/0
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CT-SOPCx FPGA/SOPC

1 FPGA Cyclone FPGA EP1C3 5
EP1C6 12 ——EP1C6 2.0
8VMbyte SDRAM  2Mbyte Flash

2 V1i.0— V2.0 USB E’PROM

3 ByteBlasterll ALTERA CPLD/FPGA
Niosl|

4 USB

5 5V

6 FPGA/SOPC

.

8

9 1602A LCD

www.21control .com
020-35511160 13760811768
Q0 26128396
Email rouder@163.com
www . 21control .com

CT-SOPCx

““CT-SOPCx~~
CT-SOPCx
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CT-SOPCx FPGA/SOPC
1. FPGA
1 FPGA led test — FPGA LED
FPGA
2 seg7led_test — Quartusll
2. SOPC Nios Il
1 sopc led — NioslI FPGA
LED SOPC
2 all _ test —— V1.0
LED LCD
3 all test USB —— V2.0
LED USB LCD
4 burn_flash_eplc6 —— Niosll IDE  Flash Programmer EP1C6
V2.0 Flash EP1C3
5 my _board —— Niosll IDE Flash Programmer EP1C6
V2.0 Flash ““Target Board”~ EP1C3
6 ucosll test —— Niosll uc/0S-11 EP1C3
QQ E-mail

E-mail

rouder@163.com ,00:26128396
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